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Eudora Reference Guide The Right Mouse Button
General Reference

The Right Mouse Button

The commands that are available from the right mouse button are generally the same as 
those on the main menu and toolbar; the right mouse button simply offers another access 
method.

To use the right mouse button commands, position the mouse pointer over a Eudora 
window and click the right mouse button (called a right-click), then select a command from 
the popup menu that is displayed. The contents of the popup menu vary depending on 
which window you are in and what tasks you might need to perform while in that window.

Right-click in an open incoming message and select View Source (if available) from the 
popup menu to view the formatting of the HTML text in a text file. Right-click in the 
message and select Send to Browser (if available) to view the HTML message in your 
Web browser.

If you want to turn the main toolbar or the status bar on or off in the main Eudora window, 
right-click on the gray area of the toolbar or status bar and select the item you want to 
show or hide: Toolbar or Status Bar.

If you have Eudora minimized as a button on the Windows 95/NT 4.0 Taskbar, you can 
check for new mail without maximizing the Taskbar button. To do so, place the mouse 
pointer over the Eudora Taskbar button, click the right mouse button, and select Check 
Mail.

Mail Storage

When you install Eudora, it creates a number of files and directories within the assigned 
directory. In addition, Eudora creates additional files and directories as needed for mail-
boxes, signatures, stationery, nicknames (Address Books), and other functions. The major 
Eudora files and directories are described below.

Attach Directory

Incoming attachments are saved in the Attach directory until you specify another directory 
using the Attachment directory button in the Attachment Options (Tools:Options:Attach-
ments). See the Eudora User Manual section “Receiving Attachments” for more details.

DirectoryServices Directory

Eudora uses the DirectoryServices directory to store the dll files for the Directory Services 
protocols that you use in the Directory Services window. See the Eudora User Manual 
section “Using Directory Services” for more details on these protocols.
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Embedded Directory

Eudora uses the Embedded directory to store JPEG image files that you insert into the 
body of outgoing messages using the Insert Picture... command under the Edit menu. 
Eudora deletes these files from this directory when the messages containing the images 
are emptied from the Trash mailbox. See the Eudora User Manual section “Inserting 
Objects in Message Text” for more details.

Filters Directory

Filters are saved in the Filters directory. See the Eudora User Manual section “Filtering 
Messages” for more details on creating and using filters.

Imap Directory

Eudora uses the Imap directory to store your IMAP mailboxes and messages.

Nickname Directory (Address Books)

Address Book entries are saved in the Nickname directory, in the default Eudora Nick-
names file. If you have created additional Address Book files, they are kept under their 
own name in the Nickname directory. See the Eudora User Manual section “Using the 
Address Book and Quick Recipient List” for more details on creating and using Address 
Book files and Address Book entries (nicknames).

Plugins Directory

The EMSAPI plug-ins are kept in the Plugins directory. See the section “Plug-ins 
(Extended Messaging Services)” in this Reference Manual for more information.

Sigs Directory

The Standard and additional signature files are kept in the Sigs directory. These files are 
stored with the .txt extension. See the Eudora User Manual sections “Using a Signature” 
and “Signature Window” for more details on creating and using signatures.

Stationery Directory

Your stationery files are kept in the Stationery directory. Stationery files are stored with the 
.sta extension. See the Eudora User Manual sections “Using Stationery” and “Stationery 
Window” for more details on how to create and use stationery files.

descmap.pce

Mappings between mailbox names and file names are stored in the descmap.pce file.

Eudora.cnt, Eudora.hlp

The Eudora.cnt and Eudora.hlp files contain, respectively, the table of contents informa-
tion and the help text for Eudora’s online help topics, accessed when you select Topics 
from the Help menu. These two files must be kept in the same directory.

Eudora.exe

Eudora.exe is the Eudora application executable file. You may find it convenient to keep a 
shortcut of this file on your Windows desktop: double-click on the shortcut icon to open 
Eudora.
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Eudora.ini

Your Options information is saved in the Eudora.ini file, along with other information. This 
file contains notes that describe each entry. For more information, see the “EUDORA.INI 
Settings File” topic in the Help Topics dialog of the online help (Contents tab), accessed 
by selecting Topics from the Help menu. Also see “The Options Dialog” in this Reference 
Manual for descriptions of many of Eudora’s options.

eudora.log, eudorlog.old

Eudora can keep records of all mail transfers. These records are kept in the eudora.log 
and eudorlog.old files. The eudorlog.old file is overwritten and a new eudora.log file is 
created when the eudora.log file reaches its approximately 100K maximum size. To 
enable logging, set the LogLevel entry in the [Debug] section of the Eudora.ini file. For 
more information, see the [Debug] section of the “EUDORA.INI Settings File” online help, 
accessed by selecting Topics from the Help menu.

filters.pce

Names and extensions for Eudora filters are saved in the filters.pce file.

finger.ini, LDAPInit.ini, ph.ini

The finger.ini, LDAPInit.ini, and ph.ini files are used to store settings information for the 
Finger, LDAP, and Ph protocols used in the Directory Services window.

in.mbx, out.mbx, trash.mbx

These files hold your mail. You’ll see files like these for every mailbox you create.

Note. These files are in UNIX mail format.

Note. Mail folders that you create are stored as directories with the .fol extension. Mail 
folders contain mailboxes and other mail folders.

in.toc, out.toc, trash.toc

These files are the tables of contents for your mailboxes. They make it much faster for 
Eudora to access your mail. You’ll see files like these for every mailbox you create.

lmos.dat

This file contains information about the messages on your mail server. (lmos = leave mail 
on server.)

nndbase.toc

This file is the table of contents for your nicknames. Extra nickname files are stored in the 
Nickname directory (see above).

nndbase.txt

Your nicknames are saved in the nndbase.txt file. Note that this file contains the nick-
names only, while the files in the Nickname directory (see above) contain the full data for 
each Address Book entry—which includes the nickname and more.
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Readme.txt

This file contains the Eudora Readme, a text file that contains important, release-current 
information and instructions that might not be included in the Eudora User Manual, the 
Eudora Reference Manual, the Eudora Quick Start Guide, or the Eudora Online Help.

*.tlx

Dictionary information is stored in the .tlx files.

Plug-ins (Extended Messaging Services)

Plug-ins are special add-ons that can be installed to add features to Eudora. For example, 
you could use a language conversion plug-in to translate a message to another language, 
a security plug-in to automatically secure a message, or a text manipulation plug-in to 
change lowercase to uppercase. Plug-ins interface to Eudora using the Extended 
Messaging Services Application Programming Interface (EMSAPI).

To make plug-ins available to Eudora, put them in the Plugins directory in your Eudora 
directory, then restart Eudora. Depending on the plug-in type, it will be available in Eudora 
in the following ways:

■ The Message Plug-ins submenu (under the Edit menu) typically includes plug-ins that 
are used to modify the text of a message. These are referred to as on-request plug-ins. 
Some samples of these types of plug-ins are available with Eudora: Sort, UpperLower, 
and Unwrap.

■ Icons in the message window are typically for plug-ins that are used to manipulate 
messages as they are sent or when they are received. These are referred to as 
on-transmission and on-display plug-ins.

■ The Tools menu typically includes plug-ins that are used to do tasks that are not 
directly related to Eudora functions. These are referred to as tools plug-ins.

■ The Attach submenu (under the Message menu) typically includes plug-ins that are 
used to create and attach particular files to a message. These are referred to as 
attachment plug-ins. (Example: QUALCOMM’s PureVoice™ voice-messaging plug-in, 
for recording and attaching voice messages to your outgoing messages.)

■ Plug-ins that are automatically used when a message is received are not available 
through the user interface. These are referred to as on-arrival plug-ins.

To see all of your currently installed plug-ins, select Message Plug-ins Settings... from the 
Special menu. The Installed Message Plug-ins dialog is displayed. If an installed plug-in 
has any settings options, you can use the Settings... button to change them. For informa-
tion about available plug-ins, send e-mail to <eudora-rep@eudora.com> or visit the 
World Wide Web site <http://www.eudora.com>.

The Messaging Application Program Interface (MAPI)

MAPI is an interface that lets you send e-mail messages from any MAPI-compatible appli-
cation, such as your Web browser, word processor, spreadsheet, graphics application, 
etc. See the section “MAPI Technical Report” in this Reference Guide for technical details 
on the Eudora MAPI server.
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MAPI-compatible applications have a Send or Send Mail option in the File menu. When 
you select the option, the Eudora MAPI server displays a new outgoing message with your 
current document attached. All you need to do is address the message, type any details 
you want to include in the body of the message, and click Send or Queue.

To run the Eudora MAPI server, set the options in the MAPI category of the Eudora 
Options dialog. To display the MAPI Options, select Options... from the Tools menu and 
click on the MAPI category (see “The Options Dialog” in this Reference Manual for more 
details).

You have several options in the MAPI Options dialog for loading the Eudora MAPI server. 
You can set it to always run or to run only when Eudora is running, or you can specify that 
it never run. These three options open or exit the server as soon as you select them.

Note. When you are running the Eudora MAPI server, Microsoft Exchange will not work. If 
you need to use Exchange, turn off the Eudora MAPI server.

You also have several options for saving or deleting MAPI attachments. When you use 
MAPI to attach a file and send a message, that file is immediately copied into the Attach 
directory (or a directory you have specified). You can use the MAPI options to save those 
copies (never delete them), or to delete them after sending their corresponding messages, 
or to delete them when their corresponding messages are emptied from the Trash.

Last, you have an option to send a single MAPI text file attachment (TXT and HTML files 
only) as an inline attachment — text in the body of the Eudora message — rather than as 
a “rider,” or normal attachment, to the message. So, for example, you can pass a Web 
page from your Web browser directly into the body of a Eudora message, for your recipi-
ents to read right in the message itself: they don’t have to open an attachment.

Putting Multiple Users on One PC

If you have a multiple-user license for Eudora, you can set things up so that more than one 
Eudora user can be on a single PC. This also works if you have multiple e-mail accounts 
(multiple personalities), but you don’t want your alternate personalities to use the same set 
of mailboxes. You will need to exit and reopen Eudora to switch users or accounts.

To have multiple users on one PC, do the following:

1 Make a separate mail directory for each user (the directories can be put anywhere you 
like, including on floppies or network drives).

2 Put a copy of the Eudora.ini file into each user’s directory. 

3 For each user, create a shortcut to the Eudora executable file (Eudora.exe). 

4 Right-click on the new shortcut and select Properties.

5 Click the Shortcut tab. 

6 In the Target field, add the path to the user’s Eudora.ini file, as shown in the example 
below. To start Eudora, each user simply double-clicks on their shortcut.
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      Specifying a mail directory
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Mail Transport

Introduction

Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing mail to your 
SMTP server machine, which in turn uses SMTP to send your mail to the world at large. 
Mail from the world at large arrives on your incoming Post Office Protocol (POP) or 
Internet Message Access Protocol (IMAP) mail server, where it waits for Eudora to pick it 
up with either POP version 3 or IMAP version 4. The mail Eudora sends and receives is 
constructed in accordance with RFC 822 and RFC 2045 (MIME).

       Eudora mail transport overview, POP (similar for IMAP)

Outgoing Mail

When you send an e-mail message to someone, Eudora uses SMTP to send the mail to 
your local SMTP server computer. That computer then sends the mail to your 
add5.01ressee’s computer, also (usually) by means of the SMTP protocol.

Why doesn’t Eudora talk directly to your addressee’s computer? For one thing, it would 
take a lot longer for your mail to leave your PC, because your PC would have to call up 
each addressee’s computer and deliver your mail. For another, some computers are “hard 
to find”; it’s much better to let another computer “hunt” for your addressee than to make 
your PC do it. Finally, sometimes your addressee’s computers won’t be available when 
you want to send mail. The SMTP server handles this by holding your mail until the other 
computer is ready to accept it, eliminating the inconvenience of having unsent messages 
hanging around on your PC.

Your Macintosh POP/SMTP 
Server

The World at Large

POP 
Check Mail

SMTP 
Send Queued Messages

SMTP

Your PC

Check Mail

Send Queued Messages
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Incoming Mail

When somebody sends you mail, other computers use the SMTP protocol to deliver the 
mail to your POP or IMAP server. Your POP or IMAP server puts mail in your “mail drop,” 
where it stays until the Eudora program picks it up. When you check your mail, Eudora 
uses POP version 3 or IMAP version 4 to pick up your mail and move it to your PC.

Why doesn’t Eudora use SMTP to receive your mail? SMTP works best when the 
computers it knows about are always ready for mail. Unless you wanted to run Eudora 24 
hours per day, seven days a week, SMTP wouldn’t work very well for you. It also doesn’t 
work well in lab environments, where you might use any number of different PCs.

More Information

If you want to know more about the Internet in general, consult the book Internetworking 
with TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP version 3, and MIME, the official 
standards are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crocker

RFC 1939, “Post Office Protocol, Version 3,” by Marshall Rose

RFC 2045, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel Boren-
stein

You can find the RFCs by anonymous ftp to ds.internic.net, in the rfc directory. Or, in 
your Web browser, go to <http://ds.internic.net/ds/dspg1intdoc.html>. See Internet-
working with TCP/IP for details.
10

QUALCOMM Incorporated



Eudora Reference Guide Where to Get More Information on MAPI
MAPI Technical Report

Where to Get More Information on MAPI

For more information, supplementary to this technical report, visit our online MAPI FAQ at 
the web site <http://www.eudora.com/developers>.

What Does MAPI Do?

Eudora’s MAPI support allows users to quickly attach documents to e-mail messages 
directly from the application that created the document. Without MAPI, users must first 
save the document, remember what folder the document is in, switch to Eudora, and then 
remember to manually attach the document to the outgoing message.

MAPI streamlines this process dramatically. To e-mail the current, open document from 
your word processor, select the Send command from your word processor’s File menu. 
This automatically activates Eudora and attaches a snapshot of the open document to a 
new composition message.

The MAPI system standardizes how messages are handled by client applications so that 
each client application does not have to have custom code for each target messaging 
application. MAPI accomplishes this by providing a standard application program interface 
used by all MAPI-enabled client applications.

An additional MAPI feature supported by Microsoft Office applications is the ability to add 
a “routing slip” to a Word, Excel, or PowerPoint document. This routing slip contains a list 
of e-mail recipients obtained from the MAPI subsystem. Once a document has an 
embedded routing slip, then it can be semi-automatically routed as an attachment via 
e-mail to all recipients listed in the routing slip. Once the routing is complete, the anno-
tated document is returned back to the original sender.

MAPI Overview

Let’s start with a picture:
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A MAPI client application is any 16-bit or 32-bit Windows application that knows how to 
access the standard MAPI messaging functions in a library known as a DLL (Dynamic 
Link Library). The functions in the MAPI DLL allow a MAPI client application to transpar-
ently and generically access a MAPI service provider. A MAPI service provider is the 
application that handles the receipt, transmission, and storage of messages. Examples of 
MAPI client applications (“front-ends”) include Microsoft Word and Microsoft Excel. Exam-
ples of MAPI service providers (“back-ends”) include Microsoft Exchange and Microsoft 
Fax.

All 16-bit client applications use the 16-bit MAPI.DLL and all 32-bit client applications use 
the 32-bit MAPI32.DLL. The MAPI and MAPI32 DLLs are “twins” which contain the same 
list of MAPI functions—they are parallel implementations of the 16-bit and 32-bit MAPI 
functions. These DLLs are provided by Microsoft as standard components of Windows 95 
and Windows NT. The MAPI DLLs are normally installed in the Windows 95 SYSTEM 
directory (SYSTEM32 for Windows NT).

As shown in the diagram on the previous page, when a MAPI client application wishes to 
send a document, it simply loads the appropriate MAPI library (DLL) and calls the defined 
MAPI functions. The MAPI DLL takes care of routing the messaging and authentication 
requests to the appropriate MAPI service provider application, displaying the address 
book user interface, and returning address book and messaging data to the MAPI client 
application. The MAPI DLL also provides an optional user interface for user authentica-
tion. For example, the user may need to supply a user name and password to the mail 
system in order to “log on” to the mail system. (The Eudora implementation of MAPI does 
not implement authentication since Eudora itself requires authentication to access the 
POP3 and IMAP4 servers.)

Eudora Pro

16-bit MAPI

client application

32-bit MAPI

client application

MAPI.DLL MAPI32.DLL
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Eudora Implementation of MAPI

Eudora implements a subset of the full MAPI library by providing two “replacement DLLs” 
for the standard Microsoft MAPI DLLs. The Eudora EUMAPI.DLL is a replacement for the 
16-bit Microsoft MAPI.DLL and the Eudora EUMAPI32.DLL is a replacement for the 32-bit 
Microsoft MAPI32.DLL. The Eudora MAPI DLLs must be located in the same directory as 
the Eudora program.

The Eudora MAPI DLLs implement the standard Simple MAPI functions detailed in the 
MAPI specification. The MAPI specification also defines Extended MAPI functions, 
however, the Eudora MAPI DLLs implement only the Simple MAPI subset.

Note. The Eudora MAPI implementation requires all MAPI client applications to use only 
the Simple MAPI functions supported by the Eudora MAPI DLLs.

MAPI client applications which use only the basic Simple MAPI calls will generally not be 
able to tell the difference between the Eudora MAPI DLL functions and the Microsoft MAPI 
DLL functions.

It is important to understand that MAPI client applications load the MAPI DLL libraries at 
runtime whenever they need to access the MAPI functions. Each client application 
expects to find either the 16-bit MAPI.DLL file or the 32-bit MAPI32.DLL file in a common, 
application-independent location (generally the Windows SYSTEM directory). Therefore, it 
is not sufficient to copy the EUMAPI.DLL and EUMAPI32.DLL Eudora DLL files into the 
Windows SYSTEM directory alongside the standard Microsoft MAPI.DLL and 
MAPI32.DLL files. For client applications to find the Eudora MAPI DLLs, the DLL files 
must be named MAPI.DLL and MAPI32.DLL. This creates a conflict since most Windows 
installations will have the MAPI.DLL and MAPI32.DLL files preinstalled in the Windows 
SYSTEM directory to support Microsoft Exchange.

Note. Eudora is able to swap the Eudora EUMAPI and EUMAPI32 DLLs with the Microsoft 
MAPI and MAPI32 DLLs when the user launches Eudora, and is able to unswap the 
Eudora MAPI DLLs when the user exits Eudora.

This approach gives the user the most flexibility and preserves the user’s ability to use 
Microsoft Exchange and/or Microsoft Fax when Eudora is not running. If we “permanently” 
install the Eudora MAPI DLLs over the existing Microsoft MAPI DLLs, then applications 
(such as the Microsoft Fax service bundled with Microsoft Exchange) which rely on the 
Microsoft MAPI DLLs will no longer work. This is clearly unacceptable for users who need 
to use MAPI for both Microsoft Exchange and Eudora.

Eudora MAPI Startup Procedure

When launched, Eudora runs the following “swap” procedure when the user has selected 
either the “Always” or the “When Eudora is running” MAPI Server option in Eudora (see 
Tools / Options / MAPI):

1 Check to see whether or not the Eudora MAPI DLLs are already installed in the 
Windows SYSTEM directory. If so, then finish.

2 Check for existing Microsoft MAPI.DLL and MAPI32.DLL files. If found, rename 
MAPI.DLL to MAPI.000 and rename MAPI32.DLL to MAPI32.000. (If a MAPI.000 file 
already exists, then Eudora uses MAPI.001, MAPI.002 etc.)
13
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3 Copy the EUMAPI.DLL and EUMAPI32.DLL files from the Eudora program directory to 
the Windows SYSTEM directory as MAPI.DLL and MAPI32.DLL, respectively.

Eudora MAPI Shutdown Procedure

When shutdown, Eudora runs the following “unswap” procedure when the user selects 
either the “When Eudora is running” or “Never” MAPI Server option in Eudora (see Tools / 
Options / MAPI):

1 Check to see whether or not the Eudora MAPI DLLs are already installed in the 
Windows SYSTEM directory. If not, then finish.

2 Delete the Eudora MAPI.DLL and MAPI32.DLL files.

3 Rename the MAPI.000 and MAPI32.000 files, if any, to MAPI.DLL and MAPI32.DLL, 
respectively. (If a MAPI.001, MAPI.002, etc. file exists, then Eudora renames the one 
with the highest number.)

Eudora DLL Swapping Restrictions

It is important to note that there are several restrictions with the above Eudora swap and 
unswap procedures: The Eudora swap and unswap procedures can only run successfully 
if the MAPI.DLL and MAPI32.DLL are not currently “in use” by one or more MAPI client 
applications.

When a MAPI client application loads a MAPI or MAPI32 DLL file, Windows “locks” the 
DLL file while the library is loaded into memory to show that the file is “in use.” Eudora can 
normally detect that the MAPI.DLL and/or MAPI32.DLL files are “in use.” If Eudora detects 
that a MAPI or MAPI32 DLL is locked, it displays an error message and skips the swap or 
unswap procedure.

When Eudora is forced to skip the swap or unswap procedure, this means that the MAPI 
DLLs are in the wrong “state” with respect to Eudora — that is, 1) the Microsoft MAPI 
DLLs could be installed even after Eudora starts, or 2) the Eudora MAPI DLLs could be 
installed even after Eudora shuts down. To prevent this from happening, use the following 
procedure when using Eudora MAPI:

1 Start Windows.

2 Start Eudora.

3 Start any MAPI client applications.

4 Send attachments to Eudora via the installed Eudora MAPI interface.

5 Shutdown all MAPI client applications.

6 Shutdown Eudora.

7 Exit Windows.

Once Eudora’s MAPI DLLs get into the wrong “state” with respect to Eudora, you cannot 
correct the state mismatch until all MAPI client applications unload the MAPI DLLs and 
Windows is able to unlock the DLL file. Since the MAPI DLLs are shared by multiple MAPI 
14
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client applications, Windows does not unlock the MAPI DLL file until the last MAPI client 
application is shut down. Therefore, to force all MAPI client applications to unload the 
DLLs, you must shutdown all MAPI client applications.

Important. When running 16-bit MAPI client applications under Windows NT, then Eudora 
cannot detect the lock placed on the MAPI DLLs by Windows unless the SHARE program 
is running. This means that Eudora can inadvertently perform the DLL swap and/or 
unswap procedures while the MAPI DLL is loaded into memory. This almost always 
causes Windows to become unstable and can lead to crashes in MAPI client applications 
as well as in Windows itself.

Note. If you run 16-bit MAPI client applications under Windows NT, then you should 
always run the SHARE program.

The good news is that Windows 95 implements the SHARE functionality without requiring 
you to explicitly run the SHARE program. By default, Windows NT only implements the 
SHARE functionality for 32-bit applications. If you are running a 16-bit application under 
Windows NT, then you must run the SHARE program explicitly.
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MIME and Mapping

What is MIME?

“MIME” stands for Multipurpose Internet Mail Extensions. MIME serves two major 
purposes — it allows mail applications to tell one another what sort of data is in mail, and 
it also provides standard ways for mail applications to encode data so that it can be sent 
through the Internet mail system.

MIME Encoding

The Internet uses the “SMTP” protocol to move mail around. SMTP is limited to the 
US-ASCII character set (see the “Mail Transport” section of this manual). This is a 
problem for people who speak languages other than American English and so need 
accented characters or non-American letters, or for people who want to use special 
symbols like the bullet.

MIME provides a way around this restriction. It offers two encodings, “quoted-printable” 
and “base64.” These encodings use US-ASCII character codes to represent any sort of 
data you like, including special characters or even non-text data.

Quoted-printable is used for data that is mostly text, but has special characters or very 
long lines. Quoted-printable looks just like regular text, except when a special character is 
used. The special character is replaced with an “=” and two more characters that repre-
sent the character code of the special character. So, a bullet in quoted-printable looks like 
“=95.”

However, there are some other things that quoted-printable does. For one, since it uses 
an “=” to mean something special, equals signs must themselves be encoded (as “=3D”). 
Second, no line in quoted-printable is allowed to be more than 76 characters long. If your 
mail has a line longer than 76 characters, the quoted-printable encoding will break your 
line in two, and put an “=” at the end of the first line, to signal to the mail reader at the other 
end that the two lines are really supposed to be one. Finally, a few mail systems either add 
or remove spaces from the ends of lines. So, in quoted-printable, any space at the end of 
a line gets encoded (as “=20”) to protect it from such mail systems.

Let’s try an example. Here’s a passage of text that you might type on your PC:

«Il est démontré, disait-il, que les choses ne peuvent être autrement; 
car tout étant fait pour une fin, tout est nécessairement pour la 
meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent btre autrement; 
car tout itant fait pour une fin, tout est nicessairement pour la 
meilleure fin.;

This corruption happens because SMTP cannot handle the special characters. However, 
if you and your recipient both have MIME, quoted-printable encoding would be used, and 
your text would show up properly:
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«Il est démontré, disait-il, que les choses ne peuvent être autrement; 
car tout étant fait pour une fin, tout est nécessairement pour la 
meilleure fin.»

While your mail was actually in transit, however, it would have looked like:

=ABIl est d=E9montr=E9, disait-il, que les choses ne 
peuvent =EAtre =autrement; car tout =E9tant fait pour une fin, tout est 
n=E9cessairement = 
pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail system. 
However, Base64 makes no attempt to be legible, and is most appropriate for non-text 
data.

MIME Labeling

The other important part of MIME is that it lets mailers communicate what kind of data is in 
a message (or part of a message). The primary mechanism used for this is the 
Content-Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the content subtype, 
and the parameters. In this case, the content type is “text,” meaning the message contains 
mostly legible text. The content subtype is “plain,” which means there aren’t any formatting 
commands or anything like that embedded in the text. Finally, “charset=iso-8859-1” is a 
parameter; in this case, it identifies the character set the message uses.

The major content types are:

textlegible text

imagepictures and graphics

audiosound

videomoving pictures

messagemessages or pieces of messages

multipartseveral different kinds of data in a single message

Practical Issues

There are really only two things you sometimes need to do with Eudora and MIME. One is 
that it may occasionally be necessary to turn off quoted-printable encoding. Another is that 
you may want to know how to define mappings between PC file extensions, MIME types, 
and Macintosh types.
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Turning Off Quoted-Printable Encoding

Eudora automatically uses quoted-printable encoding if your mail contains special charac-
ters. Eudora also uses quoted-printable encoding for attached plain text files. If your recip-
ients don’t have MIME, quoted-printable may hurt more than it helps. If that’s the case, just 
turn off the QP button in the message Toolbar when you are sending text files to those 
recipients.

Mapping Between File Extensions, MIME Types, and Macintosh Types

Since Eudora needs to have the appropriate extensions on attachment filenames in order 
to open them up from the message, Eudora has the ability to map between file extensions, 
MIME types and subtypes, and Macintosh creators and types. Messages received by 
Eudora can grab the MIME type/subtype and/or Macintosh creator/type from an attach-
ment and map that into the correct file extension. Also, on outgoing messages, Eudora 
can make sure that attachments are encoded with the correct MIME type/subtype and/or 
Macintosh creator/type depending on the file extension of the attachment being sent.

Eudora knows about some MIME types. However, since new MIME types are being 
defined all the time, it may be necessary to add to Eudora’s knowledge from time to time. 
Adding new mappings between the various types only requires editing the EUDORA.INI 
file with a text editor (like the one that comes with Eudora).

There is a section in the EUDORA.INI file labeled [Mappings], followed by some entries, 
one per line. Each entry is called a map. A map defines when the mapping should occur 
(which can be “in,” “out,” or “both”), followed by an equals sign and five parameters. These 
five parameters are (in order) the PC file extension, the Macintosh creator code, the 
Macintosh type, the MIME type, and the MIME subtype. Here are some sample entries:

[Mappings]
both=gif,,,image,gif
both=mpg,,,video,mpeg
both=doc,MSWD,,,
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=eps,,EPSF,application,postscript

A map marked “in” only tries to match the map to messages that you receive. A map 
marked “out” only tries to match the map to messages that you send. A map marked 
“both” tries to match the map to both incoming and outgoing messages.

The first map above says that any incoming MIME message that has a part type of 
“image” and subtype of “gif” will get saved to a file with the extension “.gif.” It also specifies 
that outgoing messages that have an attachment with the file extension “.gif” will get the 
MIME type of “image” and subtype of “gif” if the encoding method of the message is 
MIME. The second map is similar to the first map in structure, but uses a different file 
extension and MIME type and subtype.

You can use map entries to move between PC file extensions and Macintosh creator and 
type as well. The third map says that if an incoming message has an attachment with the 
Macintosh creator “MSWD” (which is the Macintosh creator for Microsoft Word) then the 
file extension of the attachment when saved to disk should be “.doc” (the file extension 
that Word for Windows uses). Since the map is marked as “both,” it will also give attach-
ments with the extension “.doc” on outgoing messages the Macintosh creator of “MSWD” 
if the encoding method of the message is BinHex.
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Note that the Macintosh type from this map is empty. This allows multiple types to be 
recognized with just one mapping. This is nice for “in” maps because it allows you to cover 
a range of creator/type pairs with one map. You must be careful in using this type of map 
with an “out” or “both” mapping, though, because an outgoing attachment that matched 
this map would have a Macintosh creator, but no Macintosh type. Some Macintosh appli-
cations cannot open files with a missing type. Microsoft Word for the Macintosh can open 
files without a type, so this map is fine being marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't open a file with an 
empty type. This is why there are two maps for Excel (the fourth and fifth maps above). 
The incoming map for Excel is like the one for Microsoft Word, but the outgoing map 
explicitly defines the Macintosh type.

The last map shows that you can have both Macintosh creator/type and MIME 
type/subtype in one entry. This map says that if an incoming message has an attachment 
that is encoded in MIME and has the “application/postscript” type/subtype, or has a 
BinHex attachment with the Macintosh type of “EPSF,” then the resulting file will have an 
extension of “.eps.” Similarly, if an outgoing message has an attachment with the exten-
sion “.eps” and if the MIME encoding is being used for the message, then the attachment 
will get the “application/postscript” MIME type/subtype. If the message was using the 
BinHex encoding, then the attachment would get the Macintosh type of “EPSF.”

But what happens if an attachment matches more than one map? Eudora will try and find 
the best match. For example, if you had the following [Mappings] section:

[Mappings]
in=xls,XCEL,,,
in=xlc,XCEL,XLC3,,

and you received a message with an attachment that had a Macintosh creator of “XCEL” 
and a Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file would get an 
extension of “.xlc” since the first map only matched the Macintosh creator, but the second 
map matched both the Macintosh creator and type.

Eudora can receive attachments that have both a MIME type/subtype and a Macintosh 
creator/type. Eudora understands attachments with the MIME type/subtype “applica-
tion/applefile,” which has Macintosh creator/type information embedded in it. With this 
type of attachment, Eudora will consider a match with the Macintosh creator/type as a 
“better” match than a match with the MIME type/subtype.

Finally, if an incoming attachment matches two different maps to the same degree (e.g., 
both maps have the same MIME type/subtype with different file extensions), then Eudora 
will use the file extension in the first matching map.
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Sources

Anonymous ftp (ftp.eudora.com)

QUALCOMM’s Eudora Division has an anonymous ftp server, ftp.eudora.com, that has 
information and software related to Eudora. These are located within the eudora direc-
tory. Included are POP3, Ph, and password changing servers, the srialpop program, 
current product information, dialup files, and more. Also look under the directory 
eudora/eudorapro/windows/extras.

Eudora Information

The information in this manual was correct at the time of printing. However, things happen 
very quickly in the electronic world, meaning that some of this information may already be 
out of date. For the very latest information about Eudora, send e-mail to 
eudora-info@eudora.com.

Obtaining an Internet E-mail Server

Post Office Protocol (POP) and Internet Message Access Protocol (IMAP) Servers are 
available for a variety of platforms. If you would like to run a POP or an IMAP server on 
your own system, we suggest the following servers:

■ Windows NT – QUALCOMM’s Eudora WorldMail™ Server. WorldMail supports POP3 
and IMAP4 as well as LDAP and Ph directory services. Microsoft Windows NT 4.0 
Server or Workstation is required.

■ Macintosh – QUALCOMM’s Eudora Internet Mail Server™ (EIMS). EIMS supports 
POP3 as well as Ph directory services. EIMS requires a Macintosh 68030 or higher 
(Mac IIx, IIcx, SE/30, or better) or a PowerPC.

■ UNIX – QUALCOMM’s QPopper. QPopper 2.4 is available via anyonymous ftp from 
ftp.eudora.com. QPopper versions are available for a number of UNIX systems.

■ VAX/VMS – VAX/VMS systems may try either the Multinet package from TGV, or 
IUPOP3, available via anonymous ftp from ftp.indiana.edu.

For information on QUALCOMM’s family of Internet E-mail Servers, send e-mail to 
<eudora-rep@eudora.com> or visit the World Wide Web site 
<http://www.eudora.com>.

Ph Server Source Code

A server for the Ph protocol is available via anonymous ftp from ftp.eudora.com.
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Password Change Server

Three sample UNIX servers for Eudora’s Change Password... command (on the Special 
menu) are available via anonymous ftp from ftp.eudora.com.

Windows Sockets Products

Demos of Windows Sockets 1.1 compliant stacks and applications are available via anon-
ymous ftp from papa.indstate.edu in the directory winsock-l. 

For those with World Wide Web (WWW) browsers, try the following sites:

The Consummate Winsock Applications list:http://www.stroud.com/
The Ultimate Collection of Winsock Software:http://www.tucows.com/
Stardust Technologies:http://www.stardust.com/wsd/
WinSite: http://www.winsite.com

Kerberos

You can get the necessary files and information for setting up Kerberos authentication in 
Eudora from ftp.eudora.com in the directory eudora/eudo-
rapro/windows/extras/kerberos. Be sure to read the installation instructions to ensure 
that Kerberos is set up properly.

To learn more about the Kerberos authentication system, Go to: 
http://web.mit.edu/kerberos/www

Spelling Dictionaries

There are additional spelling dictionaries that are compatible with Eudora’s built-in spelling 
checker. They are available via anonymous ftp from ftp.eudora.com in the directory 
eudora/eudorapro/windows/extras/dictionaries. To configure Eudora to use these 
dictionaries, look at the Online Help (select Topics from the Help menu) under 
EUDORA.INI Settings File, [Settings] MainLex files.
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Dialup Eudora

Introduction

As of version 4.0, Eudora no longer supports the built-in Serial Dialup (shell) connection 
method found in previous versions of Eudora. Eudora now requires that you use the 
Microsoft SLIP/PPP Dialup Networking connection method that is a standard feature of 
both Windows 95 and Windows NT 4.0.

The Microsoft SLIP/PPP Dialup Networking facility offers the following advantages over 
the retired Eudora Serial Dialup feature:

■ TCP/IP running on top of SLIP/PPP is inherently more reliable than a Serial Dialup 
connection because reliable, end-to-end data transmission is an integral feature of 
TCP/IP.

■ A SLIP/PPP dialup connection is application-independent and supports TCP/IP, IPX, 
and NetBEUI protocols. Eudora Serial Dialup was not generic and applied specifically 
to checking and sending mail with Eudora.

■ A SLIP/PPP connection supports transmission of binary data, as required by the 
IMAP4 protocol.

■ Microsoft Dialup Networking supports a wider range of modem hardware, and naviga-
tion scripts are generally modem-independent.

As with the old Serial Dialup function, Eudora can use Microsoft Dialup Networking to 
automatically dial your mail server, check and/or send mail, and then automatically hang 
up the connection.

General Steps

Following are the general steps necessary to set up Microsoft Windows to use Microsoft 
Dialup Networking. If you have already set up Microsoft Dialup Networking and can 
successfully connect to your Internet Service Provider, then skip to the section “Config-
uring Eudora to Auto-Dial the Phonebook Entry” below.

1 Make sure you have a SLIP/PPP account – You must arrange for SLIP/PPP account 
access through your Internet Service Provider. If you can choose between SLIP and 
PPP, we recommend PPP.

2 Install your modem – Configure Microsoft Windows so that it recognizes your modem 
hardware.

3 Install networking components – Configure your MS Windows networking software 
to include the TCP/IP protocol.

4 Install Dialup Networking components – Configure your MS Windows networking 
software to include the Microsoft Dialup Networking tool and the Remote Access 
Services.
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5 Define a Phonebook entry – The Microsoft Dialup Networking tool lets you create 
multiple “phonebook” entries, one for each of your Internet Service Providers. 
Configure the Phonebook entry to automatically dial the modem, establish a SLIP/PPP 
session, and, if applicable, auto-configure your IP address and DNS server 
address(es).

6 Configure Eudora to auto-dial – Eudora can use a Dialup Networking Phonebook 
Entry to automatically dial your mail server, check and/or send mail, and hang up the 
connection when the mail transfer is complete.

Configuring Dialup Networking under Windows 95

Dialup Networking is an optional component of Windows 95. Before configuring Dialup 
Networking, you should install your modem and make sure the Windows 95 networking 
software includes support for the TCP/IP protocol. Consult your Microsoft documentation 
for details on installing your modem, configuring the TCP/IP protocol, and installing the 
Dialup Networking tools.

After you install Dialup Networking, follow these steps to define a new Phonebook entry:

1 Double-click on the My Computer icon to open an Explorer window. Then double-click 
on the Dialup Networking icon to open the Dialup Networking folder.

2 Double-click on the Make New Connection button to display the Make New Connec-
tion Wizard.

3 Enter the name you want to associate with your Internet Service Provider. Also, select 
your modem in the drop-down list. Then click Next.

4 In the edit box, enter the phone number for your Internet Service Provider. Then click 
Next.

5 Click Finish on the last page of the New Connection Wizard to complete the creation 
of the Phonebook entry.

6 In the Dialup Networking folder, right-click on the icon for the Phonebook entry you 
have just created, and select the Properties command.

7 While testing your new Phonebook entry, configure Dialup Networking to display a 
terminal window after your modem has connected to the remote computer. To do this, 
click the Configure…  button to display the modem configuration properties. Select the 
Options  tab, then check the Bring up terminal window after dialing  option. Click OK 
to accept the change.

8 Back in the Properties  dialog for your Phonebook entry, click the Server Type…  
button to display the Server Types  dialog. In the Type of Dial-Up Server  drop-down 
list, select either SLIP or PPP as appropriate. Also, uncheck the NetBEUI  and IPX 
network protocols, but make sure that the TCP/IP protocol is checked. Finally, uncheck 
the Log on to network  and Enable software compression  options.

9 In the Server Types  dialog, click the TCP/IP Settings…  button to display the TCP/IP 
Settings  dialog.
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10 If your Internet Service Provider has assigned you a specific (static) IP address, select 
the Specify an IP address option, then enter that address in the field. Otherwise, if 
your provider assigns IP addresses dynamically via DHCP (Dynamic Host Configura-
tion Protocol), then keep the default Server assigned IP address setting.

11 If your Internet Service Provider supports Dynamic Host Configuration Protocol 
(DHCP), then the name server addresses will automatically be configured by DHCP, 
and you should keep the default Server assigned name server addresses setting. 
Otherwise, select the Specify name server addresses option, then enter the server 
addresses assigned by your Internet Service Provider. Click OK to accept the TCP/IP 
Settings changes.

12 Back in the Server Types dialog, click OK to accept the changes.

13 Back in the Phonebook Entry Properties dialog, click OK to accept the changes.

14 You should now be back in your Dialup Networking folder. Double-click on your new 
Phonebook entry to dial your Internet Service Provider. Your modem should immedi-
ately dial the phone number defined in your Phonebook entry, and Windows 95 should 
prompt you for your username and password.

15 Once your modem negotiates the connection with the remote system, you typically 
then have to “log in” to that remote system by entering the username and password 
assigned to you by your Internet Service Provider. Some systems require that you first 
press Enter to display a login prompt, then enter the username and password. In any 
event, once you are “logged on” (authenticated), some providers automatically start 
your SLIP or PPP session, while others require that you take an extra step, such as 
typing ppp, to initiate a PPP session. Carefully note the exact steps you must take in 
order to manually log in and establish a SLIP/PPP session: you will need this informa-
tion in order to automate the login process, as described below under “Defining a Login 
Script.”

Configuring Dialup Networking under Windows NT 4.0

Dialup Networking is an optional component of Windows NT 4.0. Before configuring 
Dialup Networking, you should make sure Windows NT recognizes your modem and also 
make sure your Windows NT networking software includes support for the TCP/IP 
protocol. Consult your Microsoft documentation for details on installing your modem, 
configuring the TCP/IP protocol, and installing the Dialup Networking tools. To properly 
configure TCP/IP, you may need some information from your Internet Service Provider 
regarding your IP address and your DNS server(s).

After you install Dialup Networking, follow these steps to define a new Phonebook entry:

1 Double-click on the My Computer icon to open an Explorer window. Then double-click 
on the Dialup Networking icon to launch the Dialup Networking tool.

2 Click the New… button to display the New Phonebook Entry Wizard.

3 Enter the name you want to associate with your Internet Service Provider, then click 
Next  to display the Server page.

4 Most Internet Service Providers use a terminal server or a Unix server to support dialup 
users. Therefore, you should generally check all three boxes to indicate that (1) you 
are calling the Internet, (2) it is okay to send your plain text password, and (3) the 
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server expects login information. Ask your e-mail administrator or your Internet Service 
Provider if you are unsure about these settings. Click Next to display the Modem or 
Adapter page.

5 Select your modem from the list, then click Next to display the Phone Number page.

6 In the edit box, enter the primary phone number for your Internet Service Provider. If 
your provider has alternate phone numbers, click the Alternates…  button and enter 
the alternate phone numbers. Click Next  to display the Serial Line Protocol page.

7 Select PPP or SLIP as appropriate to your Internet Service Provider (most providers 
now support PPP), then click Next  to display the Login Script page.

8 When initially testing dialup connections to your Internet Service Provider, we recom-
mend that you select the Display a terminal window  option. Once you can manually 
establish a dialup connection, you can then automate the dialup connection with a 
login script (see “Defining a Login Script” below for details). Click Next to display the IP 
Address page.

9 If your Internet Service Provider has assigned you a specific (static) IP address, then 
enter that address in the field. Otherwise, if your provider assigns IP addresses dynam-
ically via DHCP (Dynamic Host Configuration Protocol), then keep the default Server 
assigned IP address setting. Click Next to display the Name Server Addresses page.

10 If your Internet Service Provider supports Dynamic Host Configuration Protocol 
(DHCP), then the name server addresses will automatically be configured by DHCP 
and you should leave the default addresses of 0.0.0.0. Otherwise, enter the server 
addresses assigned by your Internet Service Provider. Click Next to display the final 
page of the Phonebook Wizard.

11 Click Finish to create your new Phonebook entry.

12 Back in the Dialup Networking tool, select your new Phonebook entry in the drop-down 
list, then click Dial to dial your Internet Service Provider. Your modem should immedi-
ately dial the phone number(s) defined in your Phonebook entry.

13 Once your modem negotiates the connection with the remote system, you typically 
then have to “log in” to that remote system by entering the username and password 
assigned to you by your Internet Service Provider. Some systems require that you first 
press Enter to display a login prompt, then enter the username and password. In any 
event, once you are “logged on” (authenticated), some providers automatically start 
your SLIP or PPP session, while others require that you take an extra step, such as 
typing ppp, to initiate a PPP session. Carefully note the exact steps you must take in 
order to manually log in and establish a SLIP/PPP session: you will need this informa-
tion in order to automate the login process, as described below under “Defining a Login 
Script.”

Defining a Login Script

Here is a sample login script for an Annex terminal server:

proc main
transmit "^M"
waitfor "Annex username:" until 30
if FALSE == $SUCCESS then

goto Failure
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endif
transmit $USERID + "^M"
waitfor "Annex password:" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit $PASSWORD + "^M"
waitfor "Permission granted" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit "ppp" + "^M"

Failure:
set screen keyboard on
halt

Done:

endproc

Based on your experience with manually connecting to your Internet Service Provider, you 
may need to change the Annex username: and Annex password: strings to match the 
prompts displayed by the machine to which you are connecting. You may or may not need 
to transmit the ppp command after the system accepts your username and password. The 
Dialup Networking tool automatically replaces the $USERID and $PASSWORD variables 
with your Dialup Networking username and password so that you don’t expose your user-
name and password in an unencrypted plain text file.

To use this login script, you must first save the file to a known location on your disk. By 
convention, Dialup Networking script files have an SCP file extension.

To use the script under Windows 95:

■ Launch the Dial-up Scripting Tool found on the Start:Programs:Accessories menu.

■ Select the Phonebook entry from the Connections list box and enter the script file-
name in the File name field.

■ Click the Apply button to accept your changes.

■ Click the Properties button to display the properties dialog for your Phonebook entry.

■ Click the Configure button to display the modem properties dialog. Then select the 
Options tab.

■ Uncheck the Bring up terminal window after dialing option. Now click OK to accept 
your changes.

■ Back in the properties dialog for your Phonebook entry, click OK to accept your 
changes.

To use the script under Windows NT 4.0:

■ Open the Dialup Networking tool, and from the dropdown list select the Phonebook 
entry you want to change.
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■ Click the More button, then select the Edit entry and modem properties…  item from 
the button menu.

■ In the Edit Phonebook Entry dialog, select the Script  tab, click the Run this script  
option, and then enter the name of your saved login script.

This script is compatible with both Windows 95 and Windows NT 4.0 Dialup Networking 
tools. If the login sequence fails, then the script will halt, leaving you free to attempt a 
manual login via the popup Dialup Networking terminal window.

Creating a Desktop Phonebook Shortcut

You may find it convenient to create a desktop shortcut to your Phonebook entry, some-
thing we recommend.

To create a Phonebook shortcut under Windows 95:

1 Open the Dialup Networking folder, then drag a Phonebook icon to your Windows 
desktop.

2 To rename the shortcut label, select the shortcut icon and press F2, or just click on the 
shortcut label twice, slowly.

To create a Phonebook shortcut under Windows NT 4.0:

1 Open the Dialup Networking tool, click the More  button, and select the Create 
shortcut to entry…  item.

2 Choose a name for the shortcut in the Save dialog, then save the shortcut to your 
Desktop folder.

To test the Dialup Networking connection, double-click on the shortcut icon on your 
Desktop. Once your Phonebook entry successfully and automatically creates a TCP/IP 
connection to your Internet Service Provider, you are ready to configure Eudora to auto-
matically dial the Phonebook entry.

Configuring Eudora to Auto-Dial the Phonebook Entry

If you connect to your Internet Service Provider with a modem, you can easily configure 
Eudora to automatically “dial on demand” using Microsoft Dialup Networking. Eudora only 
needs a connection to your provider when performing network operations such as 
checking or sending mail, or when performing a directory services lookup. When Eudora is 
configured to auto-dial, it automatically hangs up the connection when the network opera-
tion is complete.

Before you can configure Eudora to auto-dial, you must create and configure a Microsoft 
Dialup Networking Phonebook entry to automatically connect to your Internet Service 
Provider (see the procedures above).

To auto-dial a Dialup Networking Phonebook entry, start Eudora, select Options... from 
the Tools menu to display the Options dialog, then click on the Advanced Network cate-
gory. Check the Automatically dial & hangup this connection option. In the Entry list, 
select the Phonebook entry you want to dial. In the Username edit box, enter the user-
name, if any, that is required to log in to your Internet Service Provider (this is the value 
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that is substituted for the $USERID variable in your Dialup Networking script). Check the 
Save password option if you want Eudora to save your Dialup Networking password in 
the Eudora.ini file. If you leave the Save password option turned off, then Eudora will 
prompt you to enter your password each time it auto-dials the Phonebook entry.

To test the auto-dial capability, make sure your modem is not already connected, then 
select the Check Mail command from the File menu in Eudora. Eudora will automatically 
dial your Internet Service Provider, log in, establish a TCP/IP connection, transfer any new 
mail, and automatically hang up when the mail transfer is complete.
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Eudora.ini File

EUDORA.INI Settings File

The EUDORA.INI file is where Eudora keeps most of the settings. It is a standard 
Windows INI file, and may be edited with any text editor. 

Note. Note:Since Windows caches information from INI files in memory while the program 
is running, you should never change the EUDORA.INI file while Eudora is in use. If you 
need to make a change, first quit Eudora, then edit the file, and then restart Eudora.

The EUDORA.INI file is divided into a number of sections, the following of which appears 
by default:

■ [Settings]

■ [Mappings]

■ [Window Position]

■ [Tool Bar]

■ [DirectoryServices]

■ [Debug]

Optional Sections

The following sections will appear in the INI file only when the appropriate conditions are 
met or the appropriate items created:

■ [Personalities] The [Personalities] section appears only when you have created alter-
nate e-mail accounts (personalities).

■ [Stationery] The [Stationery] section appears only when you have created stationery 
files.

■ [Open Windows] The [Open Windows] section appears only when there are windows 
currently open in Eudora.

■ [WazooBars] The [WazooBars] section appears only when normal Eudora windows 
are currently open or minimized on the desktop (and thus buttons appear on the 
Eudora taskbar, which is what this section controls).

■ [Recent File List] The [Recent File List] section appears only when files have been 
opened since the most recent Eudora startup.

Note. We strongly urge that you do not change the values in these optional sections of the 
INI file, and rather make any changes from the interface. For example, personalities can 
be created and edited from the Personalities window, and stationery can be created and 
edited from the Stationery window. Both windows are available from the Tools menu.

The values of the settings in each of these optional sections reflect the current values of 
the objects or conditions; there are no "default" values per se.
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Name and Location of the INI File

The default name is EUDORA.INI and the default location is in the mail directory. But the 
name and location can be changed.

To specify a different INI file from the EUDORA.INI that is not in the mail directory, add a 
second parameter to the command line in the Program Item for Eudora, for example:

Command Line: c:\apps\eudora.exe c:\mymail c:\inis\myeudora.ini

To use a different INI file that is in the mail directory:

Command Line: c:\apps\eudora.exe c:\mymail myeudora.ini
Command Line: c:\apps\eudora.exe c:\mymail\myeudora.ini

This is a way to have multiple settings for one set of mailboxes, nicknames, etc. For 
example, you may have multiple e-mail accounts in which you receive mail, but want to 
collect mail from all of the accounts in one place. You could set up separate Program 
Items for each account (each having a different INI file on the command line), and 
switching between accounts would be as simple as double-clicking on a Program Item.

And for an even more tricky specification, if the first parameter is an INI filename without a 
path, then the mail directory is searched through the normal process of checking the 
EUDORA environment variable and then using the executable directory.

Examples:

SET EUDORA=c:\mymail
Command Line: c:\apps\eudora.exe myeudora.ini

will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

SET EUDORA=myeudora.ini
Command Line: c:\apps\eudora.exe

will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Default INI file

When an entry in the EUDORA.INI file is not found, Eudora will look in the DEUDORA.INI 
file located in the same directory as the EUDORA.EXE file. The [Mappings] section of the 
DEUDORA.INI file acts as though it was appended to the end of the [Mappings] section of 
the EUDORA.INI file.

Examples:

          SET EUDORA=c:\mymail

          Command Line: c:\apps\eudora.exe myeudora.ini

          will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

          SET EUDORA=myeudora.ini

          Command Line: c:\apps\eudora.exe

          will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.
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[SETTINGS]

   

Entry Default Value Description

AllowDefPlugins 1 Controls whether or not EMSAPI plug-ins can be auto-
matically added to the toolbar.

AllowOverwriteMode 1 Controls whether or not toggling the Insert key puts the 
message editor in to overwrite mode. Helpful for people 
who use the Ctrl+Insert and Shift+Insert accelerators 
for Copy and Paste and have a tendency to linger on 
the Insert key after letting go of the Ctrl/Shift key.

AltClickMoveSummary 1 When you hold down the <Alt> key while clicking on an 
item in a mailbox, all messages in that mailbox with the 
same item are selected (e.g. <Alt> clicking on a subject 
will select all messages in that mailbox with the same 
subject). If this switch is on, then the selected messag-
es will be grouped together as well. You can temporari-
ly turn this off by holding down the <Shift> key while 
doing the <Alt> click.

BackgroundColor 0 Specifies an RGB triple (in hexadecimal) for the color 
to use for the "workspace" area of the main Eudora win-
dow. Can be used in conjunction with the Background-
Image entry for choosing a color better suited for the 
image being displayed. Examples: white is "FFFFFF", 
black is "000000", and blue is "0000FF". This setting 
does *not* require QuickTime to be installed.

BackgroundImage 0 Specifies an image to be displayed in the "workspace" 
area of the main Eudora window (called "Application 
Background" in the Appearance tab of the Control Pan-
el->Display options). It needs to be specified as a full 
path name. This setting requires QuickTime to be in-
stalled.

BadPasswordString password When the POP server returns an error on sending the 
PASS command, the password will only be erased 
when the error response includes this text. 

BlackTocLines 0 If on, and displaying lines is mailboxes, draw lines as 
black instead of gray.

CenterUnreadStatus 1 When on (1), centers the bitmap in Mailbox menu items 
that indicate that the mailbox has unread messages. If 
the display of this bitmap is not correct, turn this switch 
off (0). 

CheckOwnerFreq 0 How often (in seconds) Eudora should check the OWN-
ER.LOK file to see if another instance of Eudora has 
been started on the same set of mailboxes.

CompactDisk% 5 What the amount of "wasted space" taken up by delet-
ed messages in a mailbox as a percentage of total free 
disk space must be before the mailbox automatically 
gets compacted when closed. 
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CompactMailbox% 50 What the percentage of "wasted space" taken up by 
deleted messages in a mailbox must be before the 
mailbox automatically gets compacted when closed. 

CompactOutgoingPlugins 0 Controls whether the outgoing EMSAPI plug-ins on the 
composition message window toolbar should be sepa-
rate buttons or contained within one button that pops 
up a list of all outgoing plug-ins. By default, all outgoing 
plug-ins get their own toolbar button.

CompSummaryItalic 1 In mailboxes other than the Out mailbox, display the 
summaries of outgoing messages in italics. 

DesDllName des32.dll The name of the DLL implementing the DES encryption 
routines for use with Kerberos version 4, e.g., des32.dll

EditAllHeaders 0 Controls whether or not the (by default, non-editable) 
From: and Attached: headers in the composition mes-
sage window. 

EnrichedSoftLine 72 Number of characters sent on a line before adding a 
soft newline when sending styled text. 

EudoraPassPort 106 Default port number for the Eudora password-changing 
service (epass). 

ExcerptBars 2 HTML style sheet parameter for excerpt bars. Can use 
this to change the width, color, and style of excerpt 
bars.
(Only works when using the Microsoft viewer).

ExtraHeaders Extra headers that are sent with each outgoing mes-
sage. If multiple headers are to be sent, separate each 
with "\r\n". For example,
"ExtraHeaders=X-Header1: foo\r\nX-Header2: bar". 

ExtraNicknameDirs List of directories to search for additional nickname 
files. Multiple directories can be entered, separated by 
semicolons (;). 

FilterFromFolder When doing a Make Filter, the name of the mailbox 
folder to place the default named mailbox that is creat-
ed when filtering based on whom the message is from.

FilterRecipFolder When doing a Make Filter, the name of the mailbox 
folder to place the default named mailbox that is creat-
ed when filtering based on whom the message is to.

FilterSubjectFolder When doing a Make Filter, the name of the mailbox 
folder to place the default named mailbox that is creat-
ed when filtering based on the subject of the message.

FindMatchCase 0 "Match Case" checkbox in the Find dialog. 

FindSummariesOnly 0 "Summaries Only" checkbox in the Find dialog. 

FirstUnreadNormal 1 When checking mail on a POP server, download any 
mail that hasn’t been retrieved at this machine.

Entry Default Value Description
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FirstUnreadStatus 0 When checking mail on a POP server, download only 
messages that haven’t been read on any machine.

FixCurlyQuotes 1 If on, then if a message contains 7-bit characters ex-
cept for directional quotes, then those directional 
quotes are turned in to regular non-directional quotes 
so that the message may be sent out as 7-bit (no quot-
ed-printable encoding needed).

GssDllName   gssapi32.dll For a user to specify the GSS/K5 DLL name.

GuessParagraphs 0 "Guess Paragraphs" checkbox in the Save As... dialog. 

IdleTime 60 The number of seconds that Eudora has to be idle be-
fore it will consider performing an automatic mail check. 

IgnoreIdleOnManualCheck0 Controls whether background tasks started manually 
(e.g. Ctrl+M to do a Check Mail) should be processed 
immediately after completing, or wait until a sufficient 
amount of user idle time (see TaskMgrWaitTime be-
low). 

IMAPLeafMenu 0 Controls whether IMAP mailboxes with no child mail-
boxes should be shown in the Mailbox/Transfer menus 
as an entire menu or just a menu item. Default is to just 
show it as a menu item. 

IMAPPreviewPane 1 Controls whether or not IMAP mailboxes have a pre-
view pane. On slower networks, it may be desirable to 
turn off the preview pane for IMAP mailboxes, but still 
have the preview pane for local mailboxes. You can do 
that by keeping the normal Preview Pane option turned 
on, but turning this setting off (setting to 0).

IMAPRemoveOnDelete 0 Controls whether or not a message in an IMAP mailbox 
that is deleted will be removed from the server mailbox 
immediately. If this setting is off (the default), then you 
can remove messages from the server mailbox that 
have been marked to be deleted by using the Mes-
sage->Remove Deleted Messages menu item. 

IncludeHeaders 0 "Include Headers" checkbox in the Save As... dialog. 

InteractiveSpellCheck 1 When doing a spell check, controls whether you get 
prompted with a dialog for each misspelled word, or 
each misspelled word gets marked with a double red 
underline (which then you can right-click on to get sug-
gestions and other options for the misspelled word). If 
you hold down the Shift key while doing a spell check, 
the other method of spell checking will be performed. 

KerberosSetUserName 0 Uses KClient SetUserName() function to set user name 
in Kerberos system. Turning this switch on may cause 
Kerberos tickets to be invalidated. 

Kerb2Dllname kerberos32.dll The name of the Kerberos version 4 DLL, e.g., 
kerberos32.dll

LastSettingsCategory 0 Last category that was displayed in the Options dialog. 

LexPath Directory in which the dictionary files for spell checking 
reside. 

Entry Default Value Description
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MainLexFiles Main dictionary files. British dictionaries can be used by 
changing this to british.tlx,british.clx 

MainWindowState 1 The state of the Main Window (normal = 1, minimized 
= 2, or maximized = 3). The state is set when Eudora 
closes, and the Main Window is set to this state the 
next time Eudora starts up. 

MaxConcurrentTasks 10 The maximum number of background tasks that can be
running at the same time. Note that if you are connect-
ed over a modem (dialup networking connection) only
one network task at a time will be run, otherwise net-
work performance would suffer greatly. 

MDNSendAddress 0 Controls whether your return address should be used 
in the MAIL FROM command for return receipts. RFC 
2298 says that it should be empty in order to prevent 
mail loops, but some SMTP servers reject that due to 
bad spam-prevention heuristics. 

NetscapeURLDDE 1 If this setting is on, when clicking on a URL in a mes-
sage and Netscape Navigator is running, then Eudora
will send the URL to that open Navigator window.  If this
setting is off (i.e. set to zero), then clicking on a URL in
a message will send the URL to the system, which will
invoke the default browser.  Some Navigator users may
want to turn this setting off if they like the behavior of
opening a new window (as opposed to reusing an ex-
isting browser window) when clicking on a URL in Eu-
dora. 

NetworkOpenTimeout 60 The number of seconds Eudora will wait for a response 
to opening a connection before it gives up. 

NewMailUpdateFrequency 25 Number of inital messages that have to be spooled be-
fore message processing begins.

NoAutoSendPrecedence list,bulk When filtering incoming messages with precedence 
headers of list or bulk, do not automatically create new 
outgoing messages. 

NoSplashScreen 0 If on, the opening splash screen will not be displayed. 

OwnerLok 1 If this is non-zero, an OWNER.LOK file will be created 
on startup which helps to prevent possible corruption if 
multiple instances of Eudora are used on the same set 
of mailboxes.

Entry Default Value Description
34

QUALCOMM Incorporated



Eudora Reference Guide [Mappings]
PasswordOKWordLis lock busy,own it,
of memory,
assign stream,
ush of temp,
being unlock,
hangup,timeout,
not owned,quota,
drop name,
recognition 
mode,accessible 
by others,
accessible by 
others,regular 
file,flock,maillock,
few minute,locked 

A comma-separated list of words that if found in the re-
sponse text from an error from the POP PASS com-
mand that will not cause the password to be erased 
(works in conjunction with the BadPasswordString en-
try above). POP servers sometimes fail after sending 
the PASS command for reasons other than your pass-
word was incorrect, and this entry allows greater con-
trol over when Eudora will decide to ask you again for 
your password. 

PhReturn A string that is appended to every Ph command before 
sending to the Ph server. For example, "PhReturn=re-
turn all" would return all fields of the records returned 
by the query, and "PhReturn=type=person" would re-
turn all matches to the query with the additional filter 
that the record is a person. 

POPPort 110 Default port number for the POP service (pop3).

PreviewHeaders To:,Subject:,Cc: A comma-separated list of headers that should be 
shown in the preview pane. The matching is done on a 
prefix basis, so any header that begins with one of 
these values will be shown.

PreviewSplitterPos 0 If non-zero, then if a mailbox hasn’t already specified a 
position for the splitter between the message list and 
the preview pane, then the splitter will be positioned 
this many pixels from the top of the mailbox window.

PreviewTableEnd </table>\r\n HTML markup for the end of the table that’s used to dis-
play the headers in a preview pane.

PreviewTableRowEnd </td></tr>\r\n HTML markup for the end of the table row that’s used 
to display the headers in a preview pane. Each header 
is displayed in a separate row of the table.

PreviewTableRowStart <tr bgcolor=%s 
text=%s><td>\r\n

HTML markup for the start of the table row that’s used 
to display the headers in a preview pane. Each header 
is displayed in a separate row of the table.

PreviewTableStart <table cellspac-
ing=
0 cellpadding=0 
width=100%% 
bgcolor=%s 
text=%s>\r\n

HTML markup for the beginning of the table that’s used 
to display the headers in a preview pane.

PrintHeaders 1 When on (1), printed messages get headers and foot-
ers. 

Entry Default Value Description
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ProgressIdle 3 Number of seconds a foreground tasks continues be-
fore the Progress window is shown. This prevents a 
distracting flash of the Progress window for a task that 
may take a long time, but in this instance only takes a 
short time. 

QuoteEnd The string that gets inserted after the original text of a 
forwarded message. A newline is added before the 
string. 

QuotePrefix > The string that precedes all lines of the original mes-
sage in a forwarded message 

QuoteStart The string that gets inserted before the original text of 
a forwarded message. A newline is added after the 
string. 

RasUseExisting Connec-
tion

1 When switching from a task from one personality to a 
task of another personality and the two personalities 
have different dialup networking connection entries, 
whether or not the already connected dialup network-
ing connection should be maintained or a new dialup 
networking connection made. It may be necessary to 
turn this setting off (set to zero) if you have personali-
ties that check mail on servers that are behind firewalls, 
and require that you dial in directly in order to connect 
to the mail server. 

ReadMessageStyleSheet <STYLE 
TYPE=""text/css""
>\r\
n{font-family = 
""%s""}\r\nTT 
{font-family = 
""%s""}\r\nBLOCK
QUOTE.CITE 
{border-
left = solid 
%s}\r\nBLOCK-
QUOTE.CITE 
{padding-left = 
0.5em}\r\nBLOCK
QUOTE.CITE {m
argin-left = 
0}\r\nBLOCK-
QUOTE.CITE 
{margin-top = 
0.5em}\r\n

HTML style sheet used for displaying received mes-
sages.

ReadRecieptAsk 1 Ask user for read receipts. 

ReadRecieptNo 0 Always deny read receipts without prompting.

ReadRecieptYes 0 Always return read receipts without prompting. 

ReplyAllAttribution At %1, %2
you wrote: 

Attribution line when a Reply to All is done. 

ReplyAttribution At %1, you wrote: Attribution line when a Reply is done. 

ReplyEnd The string that gets inserted after the original text of a 
replied message. A newline is added before the string. 

Entry Default Value Description
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ReplyPrefix > The string that precedes all lines of the original mes-
sage in a replied message

ReplyStart The string that gets inserted before the original text of 
a replied message. A newline is added after the string. 

ReservedDosNames aux,com1,com2,c
om3,com4,con,lpt
1,lpt2,lpt3,lpt4,nul
,prn

Reserved names of files that will not be used for filena-
mes of attachments. These filenames are reserved for 
DOS, and can causes problems in actual files with 
these names are created. 

ReturnAddressFormat %1 < %2> Format of the From: field in outgoing messages. %1 is 
the Real name, and %2 is the Return address. 

SaveDialupPasswordText Where your dialup password is saved (in an encrypted 
format) if you have the Save Password switch turned 
on. 

SavePasswordText Where your POP password is saved (in an encrypted 
format) if you have the Save Password switch turned 
on. 

SearchAllmapAccounts 0 Controls whether all of your mailboxes in all IMAP ac-
counts will be looked at when searching, or just the 
mailboxes in the IMAP account that you start the 
search in (applies to local mailboxes as well, i.e. a 
search starting in a local mailbox will only search your 
local mailboxes if this setting is off).

SendXAttachHeader 0 Controls whether or not the X-Attachment: header 
should be sent out with outgoing messages that con-
tains attachments.

ShowAttachmentIcons 1 Controls whether or not icons representing attach-
ments should be shown in the body of the message. 

ShowMeTheErrors 0 Controls whether or not to show the error dialog imme-
diately on send/receive errors. By default, errors are 
listed in the Task Errors window, and that window is 
brought to the foreground. 

ShowProgress 1 Show/hide the Progress window. 

ShowProgressInactive 0 If Eudora is not the foreground application, this controls 
whether the Progress window should be shown or not.

SMTPPort 25 Default port number for the SMTP service (smtp). 

SMTPRecipientWrap 72 Column at which recipient headers (To: and Cc:) are 
wrapped when sending a message. 

StatBarBlink 0 Controls whether or not the icon shown in the status 
bar for tasks that are waiting or have errors should 
blink. 

StatBarErrorAnimation-
Rate

250 Controls the speed of the animated icon in the status 
bar for tasks that are currently waiting (units in millisec-
onds between images). 

StatBarGraphWidth 100 The width (in pixels) of the background task progress
bar that shows up in the status bar. Set to zero to pre-
vent the progress bar from being displayed. 

Entry Default Value Description
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StatBarErrorRunningAni-
mationRate

125 Controls the speed of the animated icon in the status 
bar for tasks that currently have errors (units in millisec-
onds between images). 

StatBarWaitingAnimation-
Rate

500 Controls the speed of the animated icon in the status 
bar for tasks that are currently waiting (units in millisec-
onds between images). 

StationerySignatureRules 1 Signature precedence is as follows: User’s selection; 
Stationery’s signature; Personality’s signature. Set this 
to 0 to put Personality’s signature before Stationery’s. 

StripDuplicateAddresses 1 When replying to a message, controls whether or not 
duplicate copies of your e-mail address will be removed 
from the To: and Cc: headers. This helps to avoid build-
up of your email address in email conversations. Strip-
DuplicateAddresses has been shown by the ADA to be 
an effective decay preventive dentifrice that can be of 
significant value when used as directed in a conscien-
tiously applied program of oral hygiene and regular pro-
fessional care.  Four out of five dentists prefer 
StripDuplicateAddresses over the leading products at 
preventing email address buildup. 

SwitchPreviewWithTab 1 When on, pressing the <Tab> key in a mailbox will 
switch focus between the message list and the pre-
viewed message.

TabooHeaders X-UID,Received,
Status,X-UIDL, 
Message,In-
Reply,X-Priority,
Mime-Version,Co
ntent-X-Persona,
Resent-Message,
Referenes,Return
,X400,X-400,Mail-
System,Errors-To
,X-List,Delivery,
Disposition,
X-Juno,
Precedence,
X-Attachments,
X-MSMail,
X-MimeOLE

A comma-separated list of headers (without colons) 
that should not be shown when the "Show all headers" 
switch (the "Blah Blah Blah" icon) is off for a message. 
The matching is done on a prefix basis, so any header 
that begins with one of these values will not be shown. 

TabSpaces 0 If on, then when the Tab key is pressed while the cursor 
is in the body of the message, spaces are inserted in-
stead of a tab character. 

TabStop 8 How many spaces to insert for a <Tab> in the body of 
a composition message. 

TaskErrorKeepAll 0 When set, Eudora will not automatically remove errors 
from the task error list.

TaskErrorLinesPerRow 3 Number of lines for each error in the Task Errors win-
dow.

Entry Default Value Description
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TaskErrorRemoveFromList1 Controls whether or not to remove errors from the Task 
Errors window after seeing the corresponding error di-
alog. 

TaskMgrWaitTime 20 The number of seconds in which the user has to be idle
in Eudora (which is defined as pressing any key or
mouse button) before background tasks are processed
(see IgnoreIdleOnManualCheck above for an excep-
tion case). 

TaskStatusGraphBorder-
Color

0,0,0 RGB color of the border of the progress bar in the Task 
Status window. 

TaskStatusGraphComplet-
ed Color

18,106,254 RGB color of the completed portion of the progress bar 
in the Task Status window. 

TaskStatusGraphRemain-
Color

129,207,254 RGB color of the remaining portion of the progress bar 
in the Task Status window. 

TaskStatusRecvGraph-
CompletedColor

18,106,254 RGB color of the completed portion of the progress bar 
in the Task Status window for receiving mail.

TaskStatusRecvGraphRe-
mainColor

129,207,254 RGB color of the remaining portion of the progress bar 
in the Task Status window for receiving mail. 

TocDateLeeway 10 Number of seconds that the date on a mailbox .TOC file 
can be behind the .MBX file that Eudora will not flag as 
being out of date. Helpful for network file systems, es-
pecially Windows NT Server which seems to have 
problems correctly time/date stamping files. 

UnreadExpires 5 The number of days after which a message is no longer 
used to determine if a mailbox has unread messages in 
it. 

URLHelper The full path of the application used to launch URLs. 

URLHighlight 1 Display URLs in blue underline style. 

UsePOPSend 0 If UsePOPSend is on, Eudora will send mail using the 
POP3 extended command XTND XMIT. Since this is 
an optional command for POP3, many POP3 servers 
do not support this command (Berkeley’s popper, how-
ever, does). There are pros and cons to using POP3 to 
send your mail. It provides a level of security since it re-
quires a username/password pair to send mail mes-
sages, unlike SMTP. It is faster than SMTP, especially 
when checking for new mail at the same time. It doesn’t 
check for valid recipients until the entire message is 
sent, and some implementations (Berkeley’s popper, 
for example) won’t tell you which recipients are invalid 
and will send the message to the valid recipients any-
way. 

UserChangeLex uchange.tlx Filename of user-defined list of words to change when 
spell checking. 

UserIgnoreLex uignore.tlx Filename of user-defined list of words to ignore when 
spell checking. 

UserSuggestLex usuggest.tlx Filename of user-defined list of words to suggest when 
spell checking. 

Entry Default Value Description
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[Mappings]

This is a sample [Mappings] section. It is not a default for Eudora if you have a missing or 
empty [Mappings] section. The [Mappings] section contains information for mapping 
between PC file extensions, Macintosh creator and type, and MIME type and subtype for 
attachment files (in that order). Entries marked "in" work on only incoming messages, and 
entries marked "out" work on only outgoing messages. Entries marked "both" work on 
both incoming and outgoing messages.

For a more detailed explanation, see the "MIME and Mappings" section of the Eudora 
Reference Guide.

out=txt,ttxt,TEXT,text,plain
both=doc,MSWD,,application,msword
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=xlc,XCEL,XLC3,,
both=xlm,XCEL,XLM3,,
both=ppt,PPT3,SLD3,,
both=wp,WPC2,.WP5,application,wordperfect5.1
both=zip,,,application,zip
both=rtf,,,application,rtf
both=ps,,,application,postcript
in=eps,,EPSF,,
out=eps,dPro,EPSF,application,postscript
both=mpg,,,video,mpeg
both=jpg,,,image,jpeg
both=gif,,,image,gif
both=tif,,,image,tiff
both=pct,,PICT,,
both=mac,MPNT,PNTG,,

WordWrapColumn 76 When the "Word wrap" switch is on, this is the column 
in which lines in outgoing messages are wrapped. 

WordWrapMax 80 When the "Word wrap" switch is on, this is the length at 
which a line in an outgoing message is considered too 
long and must be wrapped. 

WordWrapOnScreen 0 If this is on (set to non-zero), then the composition win-
dow will automatically wrap text on the screen at the 
number of characters specified in WordWrapColumn, 
regardless of the width of the window.

Entry Default Value Description
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[Window Position]

The [Window Position] section saves the positions of the standard windows (not your 
mailbox windows and message windows).

[Tool Bar]

This section reflects the current settings of the main Eudora toolbar. If you create addi-
tional Eudora toolbars, then additional [Tool Bar] sections will appear in the INI file.

Note. We strongly recommend that you do not change any of the settings in the [Tool Bar] 
section(s) of the INI file, and that you instead make any changes to any Eudora toolbar 
from the toolbar customization dialog (Customize dialog). This dialog is accessed by 
right-clicking anywhere on the toolbar and selecting Customize... from the pop-up menu. 
For more information, see "Customizing the Main Toolbar" in the Eudora User Manual.

[DirectoryServices]

The [DirectoryServices] section controls the use of the Directory Services window 
(accessed from Eudora’s Tools menu) and its associated databases. For more information 
on Directory Services, see its dedicated section in the Eudora User Manual.

Note. Of the entries listed below, only those marked with an asterisk (*) are user-settable.

Entry Default Value

CheckSpellingWindowPosition 0,0,0,0

FindWindowPosition 60,345,580,480

MainWindowPosition 0,0,640,480

ProgressWindowPosition 0,0,0,0

SignatureWindowPosition 10,60,630,240

TextFileWindowPosition 0,0,600,460

Entry Default 
Value 

Description

OldKeepOnTopConverted What in pre-4.0 versions of Eudora used to be [Settings] 
AddressKeepForeground is now KeepOnTop in this sec-
tion. KeepOnTop saves the check state of the "Keep On 
Top" check button in the Directory Services window. Eu-
dora uses this entry (OldKeepOnTopConverted) to de-
termine if the AddressKeepForeground entry from a 
pre-4.0 version of Eudora has been mapped to the cur-
rent version. When Eudora 4.x is run for the first time, it 
sets the KeepOnTop entry (described below) equal to 
the value of AddressKeepForeground. In addition, it also 
sets this entry equal to 1 so that the next time Eudora is 
run, it reads the check state from KeepOnTop rather 
than from AddressKeepForeground. 
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PanesY* This entry reflects the height of the Directory Services 
window when Eudora was last shut down. 

LeftPaneX* This entry reflects the width of the left pane of the Direc-
tory Services window when Eudora was last shut down. 

RightPaneX* This entry reflects the width of the right pane of the Di-
rectory Services window when Eudora was last shut 
down. 

KeepOnTop* This entry reflects the check state of the "Keep On Top" 
check button in the Directory Services window when Eu-
dora was last shut down. 

LDAP:ldap.bigfoot.com* This entry reflects the check state of the LDAP database 
"ldap.bigfoot.com" when Eudora was last shut down. 
The check state of other LDAP databases is reflected in 
similar entries. 

Ph:ph.bigfoot.com* This entry reflects the check state of the Ph database 
"ph.bigfoot.com" when Eudora was last shut down. The 
check state of other Ph databases is reflected in similar 
entries. 

Eudora Address 
Book:Eudora Nicknames* 

This entry reflects the check state of the Eudora Address 
Book database "Eudora Nicknames" when Eudora was 
last shut down. The check state of other Eudora Address 
Book databases is reflected in similar entries. 

Finger:hostname.
domain.com*

This entry reflects the check state of the Finger database 
"hostname.domain.com" when Eudora was last shut 
down. The check state of other Finger databases (or 
daemons) is reflected in similar entries. 

DIRSERV-Major This entry reflects the major version of DirServ.dll that 
was last registered. Combined with the minor version of 
this DLL (see the next entry below), Eudora at run time 
determines whether the DLL is a newer version than the 
one last registered so that it can register the new COM 
objects, if any, in the newer DLL. 

DIRSERV-Minor This entry reflects the minor version of DirServ.dll that 
was last registered. See the description above for 
DIRSERV-Major. 

ISOCK-Major This entry reflects the major version of ISock.dll that was 
last registered. A similar description as the one in 
DIRSERV-Major above applies. 

ISOCK-Minor This entry reflects the minor version of ISock.dll that was 
last registered. A similar description as the one in 
DIRSERV-Major above applies. 
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[Debug]

The [Debug] section controls aspects of the Eudora log file. The Eudora log file is a handy 
tool for debugging network connections, especially when using the dialup connection 
method.

EUDORABK-Major This entry reflects the major version of EudoraBk.dll that 
was last registered. A similar description as the one in 
DIRSERV-Major above applies. 

EUDORABK-Minor This entry reflects the minor version of EudoraBk.dll that 
was last registered. A similar description as the one in 
DIRSERV-Major above applies. 

LDAP-Major This entry reflects the major version of Ldap.dll that was 
last registered. A similar description as the one in 
DIRSERV-Major above applies. 

LDAP-Minor This entry reflects the minor version of Ldap.dll that was 
last registered. A similar description as the one in 
DIRSERV-Major above applies. 

PH-Major This entry reflects the major version of Ph.dll that was 
last registered. A similar description as the one in 
DIRSERV-Major above applies. 

PH-Minor This entry reflects the minor version of Ph.dll that was 
last registered. A similar description as the one in 
DIRSERV-Major above applies. 

Entry Default Value Description

LogFileName EUDORA.LOG The name of the log file. 

LogFileSize 100 The size (in KB) of the log file that, when reached, 
will cause the log file to be copied to the file EU-
DORLOG.OLD and a new log file to be started. 
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LogLevel 11 (which is bits 1, 2, 
and 4)

A bit-mapped value telling what type of information 
to log:
Bit 1 (1): Sending of a message
Bit 2 (2): Receipt of a message
Bit 3 (4): Dialup script navigation commands
Bit 4 (8): Alert messages
Bit 5 (16): Progress messages
Bit 6 (32): All bytes sent
Bit 7 (64): All bytes received 
Bit 8 (128): Corrupt mailbox TOC file messages
Bit 9 (256): Basic EMSAPI translator messages
Bit 10 (512): Advanced EMSAPI translator mes-
sages
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